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Billing and General
Information about billing, servicing and policies related to working with Shovi

Websites.

"Website Updates" Policy

Effective as of March 19, 2009.

Updates, previously called "Support Units," are defined as individual requests to manage content on
a client's website. 

Examples of a Standard Update include, but are not limited to:

    changing existing copy on an existing web page, 
    adding new copy to an existing web page, 
    creating 'banners' or other graphics that link to pages within your website using previously
defined dimensions and specs,
    adding incremental content to an existing section using previously defined parameters (such as
adding a press release with associated photo and caption). 

Help Desk Requirement. All updates must be processed through our Help Desk system, either by
submitting a ticket or emailing updates@shovi.com with the request. We guarantee that all requests
will be completed within 2 business days, provided that the information submitted in the original
ticket is complete, and there are no follow-up questions. Once all support information has been
received and questions answered/confirmed, the 2 business day timeline begins.

Telephone Requests.  We encourage communication via email for optimum efficiency; however, we
are available during the hours of 10:00 AM through 1:00 PM for brief discussions on support issues
via telephone.  Limiting support via telephone increases the accuracy and efficiency with which we
can process update requests and allows availability for sales and development discussions with our
clients.

Guarantee. We guarantee the completion of your ticket within 2 business days provided it complies
with the requirements above. In the event an update that complies with all of our Standard Updates
requirements takes longer than 2 business days we will not count it toward the number of updates
included in the client's Site Management plan.  

"Day 1" starts at 8:00 AM, "Day 2" ends at 5:00 PM the next business day.  If a ticket arrives in our
Help Desk at 3:00 PM on a Thursday, its first day of the 2-day guarantee is Friday, the second day is
Monday.  If a ticket arrives in our Help Desk at 7:45 AM on a Thursday, the first day of the 2-day
guarantee is Thursday, the second day is Friday.  All times are Eastern (US).

Proofs.  Unless you specifically request otherwise, Updates will be made live, not "for proof;"
therefore it is important that you 'vet' or otherwise approve the format of the updated content prior
to submitting it to the Help Desk.  Should you require a proof page first, make the request explicitly
when you submit the update, which will not qualify for the 2 business day completion guarantee.  If
a proof is required, we will provide a single round of edits (if required) after which the edits will be
made live and the ticket closed.  If, during the proof and reply period, you request more rounds of
proofs, this will no longer be considered an Update. The ticket will then be converted to a billable
service.

Tracking. It is the your responsibility to track the number of updates submitted through our Help
Desk ensure they do not exceed the preset number of updates specified in your Site Management
plan.  Should you exceed their preset number of updates, additional requests will be billed
automatically at the appropriate billing rate, usually $25/request.  By registering as a user with the
Help Desk you can easily track the activity on your account.

Premium Updates.  In the event you require completion sooner than the standard 2 business day
timeframe, Shovi Websites will automatically bill the client at a rate of $60/hour with a $25
minimum, even if the client's Site Management plan still has Standard Updates available.  "Same
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Day" updates are not guaranteed after 1:00 PM.

Rollover.  There is no "rollover" of unused updates. However, Shovi Websites will monitor your
updates and take inactivity into account when pricing billable requests, such as website redesign,
email marketing or a programming feature.

Technical, Hosting, Email Support.  Where possible, all requests for technical, hosting or email
support must be made through our Help Desk in the appropriate Department. The more specific you
can be in providing details about the issue or error, the easier it will be for us to troubleshoot. In
the event of a true emergency, you can contact our offices at any time.  

Generally speaking, we do not want to make technical support a billable item that requires
guidelines and parameters as outlined above & below.  However, in an effort to keep this service a
free one, we may suggest online references on the appropriate topics to discuss with your IT
department.  If all else fails, Shovi Websites reserves the right to bill the client for time spent
troubleshooting their specific issue.

Pricing and Scope of Non-Update Servicing. If a request does not fit within the parameters of a
Standard Update according to the above Website Updates Policy, we reserve the right to provide a
quote for the request at the appropriate billing rate using the table below.  Rates are subject to a
1/3 hour minimum.  At times, Shovi Websites may elect to forego billing for certain requests as a
matter of good faith and business; these decisions are isolated and should not be considered 'rule of
thumb' by the client.

    
        
            Service Category
            Rate/Hr
        
        
            Programming/Dynamic Content Support
            $120/hr
        
        
            Marketing (eCampaigns, SEO, PPC)
            $90/hr
        
        
            Graphic Design (banners, Flash)
            $90/hr
        
        
            Analytics/Campaign Support
            $75/hr
        
        
            "General" Billing Rate
            $75/hr

Billing Procedure

Because Shovi Websites provides ongoing services to its clients each month, we have implemented
the following billing procedure and schedule:

    Your monthly Site Management plan is billed in advance for the month. 
    Any billable work completed between billing dates is added to your Statement and sent along with
the next Billing Statement; unless otherwise instructed we do not send invoices for special projects
or jobs. 
    Billing Statements (we do not send invoices) are sent on the 1st of each month, due the 1st day of
the upcoming month. 
    We send our bills via email with a PDF attachment unless otherwise instructed by our client. 
    While we accept all major credit cards we prefer to receive checks.  If a client would prefer to pay
by credit card we will send them a customized payment link. 
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DEPOSITS:  Typically Shovi Websites will require a partial payment on a large project in order to
schedule and commence work.  We typically ask our clients to process the proposal as the "invoice"
for this deposit as opposed to generating a special invoice.  The payment and deposit will be
reflected on the next billing statement.

CONTACT:  If you have any questions or need to discuss our billing procedures please contact us at
781-538-5901.

Late Fee Policy

ATTENTION SHOVI WEBSITES CLIENTS:  The following late fee policy was placed in effect as of
March 5, 2008.  It is your responsibility to check our website for any policy updates.

Please see our Billing Procedure article for our general billing cycle info and terms.

    Beginning April 1, 2008 we will now send out our billing statements on the 1st of the month, due
the 1st of the coming month. 
    Accounts whose balances are not received by the 1st of the month will be subject to a $25 late
fee, which will be assessed on the next bill.  Please allow adequate time for processing and postage. 
    Accounts that go 60 days past due will be temporarily suspended from our servers until such time
that all balances are paid to date, including a $150 reinstatement fee. 
    Accounts that go beyond 60 days past due may also be placed in collection; client will be
responsible for any associated fees in conjunction with their outstanding balances. 

If you require assistance with payments or have questions about our Late Fee Policy please contact
us as soon as possible to avoid any disruption in service. We are happy to work with you.

Website Content Manager (WCM) License Agreement

BY INSTALLING SHOVI WEBSITES SOFTWARE AND BY USING SHOVI WEBSITES SOFTWARE YOU
ACCEPT, AGREE TO AND AGREE TO BE BOUND BY THIS LICENSE AGREEMENT. 
1        - SOFTWARE INFORMATION
 Shovi Websites is the sole owner of all logos, help docs, code, and other related materials. This is a
non-transferable ownership. Obtaining a license does not provide legal ownership over any of the
above.
2 - LICENSING DETAILS
 For each license you may use that software in one (1) location / domain. The number of active
copies of software must match or be below the number of licenses that you have been provided. We
reserve the right to void your technical support & upgrades and/or pursue legal action if this is
violated.
3 - LIMITATIONS
 With the purchase of a license you may not do the following:

    Exceed the number of licenses provided by using multiple copies.
    Copy the software, help docs, code, or graphics.
    Remove comments that exist within the code. Note: These comments are        not visible to users.
Only in the source code.
    Make attempts to discover the source and or algorithms involved
    Disclose or release any code, documentation, proprietary know-how,        or content.
    Reverse engineer or use any code / algorithms involved in any other        way than direct use with
the software.
    Resell the software directly without an initial agreement with Shovi Websites
    Sub-License or rent any area of the software, script, or any part        of the software package.
    Transfer ownership of the software.
    Claim ownership and/or creation of the software. 

4 - WHAT WE MAY DO
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 Shovi Websites reserves the right to monitor your license usage. This includes the monitoring of
your license and we will never collect any information beyond license information such as serial #'s
and locations of usage. Shovi Websites also reserves the right to void your technical
support/upgrades and/or pursue legal action if any part of this license agreement has been violated.
5 - LICENSE TERMS
 This license agreement is automatically activated upon installation and upon receiving the Shovi
Websites software. You may terminate this agreement by erasing all copies of the software or
dissolving your relationship with Shovi Websites. This includes all source files, documentation, and
database structures.
6 - LIABILITY
 In no event shall Shovi Websites be liable for any damages and/or losses including security issues,
data, bugs, losses, or any other damages. 
If you have a situation in which you feel you may be conflicting with the license agreement, please
contact us. Each situation is met on a case-by-case basis.

Domain Registration
Answers about domain registrations on ShoviDomains.com.

How do I point a domain name I purchased to Shovi's servers?

When you purchase a domain name at www.ShoviDomains.com, you have total control over where
the domain, and its various DNS entries, point.  In nearly all cases, a domain purchase at
www.ShoviDomains.com will be for a domain hosted on one of our servers, so you will need to point
the domain to our name servers.

once logged in at www.ShoviDomains.com, click the MY PRODUCTS link at the top of the page. 
Then click the "Domain Manger" link.  A different screen will open up with all of your domains listed.

Simply click the domain you wish to point to our servers, and then click the "Nameserves" icon. 
Change the name servers to read "ns1.theplanet.com" and "ns2.theplanet.com" in the first two
fields, respectively.

Changing name servers may result in downtime or confusion for email traffic for approximately 24-
72 hours.  Contact us with any questions, or add Shovi Websites to your account as an Account
Exec so we can manage the nameserver setup for you.

If you would like to keep control over all of your DNS entries and just point the website to our
servers, contact us to learn the correct DNS entries and IP addresses.

How to transfer a domain name to ShoviDomains

With the addition of our new domain registration service, www.ShoviDomains.com, clients have the
ability to consolidate their domain name registrations with the same company that is managing their
website.

The entire process, assuming no issues or delays, takes about 5-7 business days and is very simple.

WHAT YOU NEED:

    Access to the email address for the Administrative Contact or Registrant for the domain to be
transferred. Without this you will not be able to complete the transfer, so resolve this issue with the
current registrar first. If you can log into the existing registrar account as the owner (not a secondary
contact) you can change your email address. this is the most common issue that will delay the
transfer process. 
    The domain needs to be un-locked at the current registrar. 

HOW IT WORKS:
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    Once the domain has been unlocked and you have access to the Administrative email address for
your domain, go to www.ShoviDomains.com 
    In the orange band near the top of the page, mouse over the phrase "Domain Names" then select
"Transfer Domains" from the drop-down menu.
    Enter the domain you want to transfer in the box labeled "STEP 1", then complete the rest of the
purchase. (The transfer purchase is the same as buying a domain for the first time, the difference
comes after the purchase) 
    When the purchase is complete you will receive an email receipt to the email address you
specified in the transaction. 
    Within an hour or two, the Administrative email address on your domain will receive a plain text
email with two important items: a security key and a transaction code. 
    Go into the existing registrar and obtain the Auth Code for your domain. 

THE TRANSFER:

    Armed with the three codes (security key & transaction code from the email, and the Auth Code
from your unlocked domain), go back to www.ShoviDomains.com. 
    Log back in if necessary (if you're logged in, you will see a "Welcome" message in the very top
band to the right. If not, you'll see a login box).  When you are logged in you'll see a series of
buttons on the left side of the page. 
    Under "My Account" click "Pending Domain Transfers". A new screen will open up. 
    You should see your domain in the new screen. Click the checkbox next to it and then "Begin
Transfer" 
    The area above the domain will open up, asking you to input those three codes. Once you're
finished, the registrars will take it from there. 

You will receive an email from your existing registrar within 1-2 days of the transfer request, asking
you to confirm it. BE CAREFUL AND READ THIS EMAIL! Some registrars "assume" you made a grave
mistake by allowing a transfer (seriously, after all those steps above you don't think you wouldn't
have caught yourself?) and ask you to click a link to confirm you DON'T want to transfer, effectively
cancelling the transaction.  Despicable, yes, but when you charge 3x the amount for a domain
name as the rest of the market, you need to get creative to keep your customers! 

The normal course of action is to ignore the email from your registrar if you want to ALLOW the
transfer to take place.  But read the email regardless, because if you don't, and you miss an
important confirmation step, you'll have to do this all over again.

We are of course happy to help in any way we can, but this is the actual series of steps to transfer a
domain name to ShoviDomains.com.

Adding Shovi Websites as an Account Exec

If you have purchased a domain name through www.ShoviDomains.com chances are it is in
conjunction with a website launch that we will be hosting for you.  Please see this article on how to
change the nameservers for your new domain to point to our servers, OR read below for how to add
Shovi Websites as an Account Exec so we can do it for you.
Assign Shovi as an Account Exec

    Log into your account at www.ShoviDomains.com 
    Click the "My Account" tab on the left, then the "Domains" link to open up the Domain Manager
screen
    Click the "Folders" link on the left menu of the Domain Manager screen  
    Click the checkbox next to "All My Domains" and then click the Account Exec icon above.  
    A box will open asking you to assign an Account Exec. Select "New Account Exec".  
    A new window will appear asking you to fill out the following information for your Account Exec: 
First Name: Shovi 
Last Name: Websites 
Email: 
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Confirm Email: 

 
    It is important that you provide the email address listed above. Complete the confirmation steps
so we can receive the email invitation, which we will accept and then have access to your domains
via our own account. From there we will change the necessary nameserver information for this and
any future domains you purchase from us.

eCampaigns Email Marketing Service
articles, pointers and how-to information on using & making the most of email

marketing through eCampaigns.

Great Email Marketing Comments from...guess where...a SPAM Message!

Thank heaven for my anti-spam protection, my inbox is spared from about 200 emails per day that
don't belong there.  However, the compulsive e-mailaholic that I am still checks my blocked queue
for messages that may not warrant being banned from the happy journey from server to Shovi World
Headquarters.

Today we found a piece of unsolicited email that was both ironic and worth sharing.  The email
came from an email marketing company trying to get me to sign up with them (little did they -- or
whomever put me on this list -- know that we have our own email marketing system, eCampaigns). 
The content was the answer to something we've heard before so it's worth sharing...enjoy!

Whenever I meet with a new client, it seems I always get asked the same question:

"Do you have access to lists of email addresses for purchase?"

It never fails. With email marketing as cost-effective as it is, almost all companies are intrigued by
the possibility of getting their email out to tens of thousands of potential new customers. And why
not? After all, what company hasn't purchased a "snail mail" list as part of their direct mail efforts?

At first glance, it makes a ton of sense. But a closer look at the nature of email marketing teaches us
that, unlike direct mail, the purchase of email lists can do more harm than good.

Quite simply, email is not direct mail. 

There are so many reasons why, but it mainly boils down to customer control. With email, your
customers expect to be in control of the relationship. They decide whether or not they want receive
email from you, what kinds of information to receive, when they're ready to unsubscribe, even when
they're so annoyed by your emails that they (heaven forbid) click on the "this is spam" button. 

Unlike direct mail, customers have come to expect that kind of control with email. Plain and simple,
they don't want to receive spam from you. 

So if you do choose to send out unsolicited email...sure, there may be a few (very few) potential new
customers who will be intrigued by what you have to offer and seek further information. But chances
are very high that even more recipients will get annoyed by the disturbance and make a beeline for
the "this is spam" button. 

And if enough people do just that, well, good luck getting your future emails delivered - even to
customers who have opted-in to your mailings. Internet Service Providers such as Hotmail, Yahoo,

6 of 25Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



AOL, etc. now think you're a spammer, and will send your future emails directly to their customers'
"spam" folder.

And besides...how eager would you be to do business with a company that sends you spam?

If you're bummed about all this, relax. You're almost guaranteed to get great results from your in-
house list, made up of people who have asked to receive information from you. They're not only
willing to receive your emails, they're often excited to hear from you!

Text formatting, page encoding and "smart quotes"

Smart quotes (or "curly" quotes) - there's an issue with the way text readers interpret them, so if
you ever paste them into a WYSIWYG editor you run the risk of the quotes coming out VERY funny
looking.
 
Generally, people using our WYSIWYG editors are publishing their content after typing it out in MS
Word or other word processor.  This creates extra formatting tags that can be easily copied and
pasted into a WYSIWYG editor, BUT the formatting may not be correct HTML formatting.
 
To avoid this issue, we recommend using straight quotes.
 
1) turn OFF smart quotes in your Microsoft Word settings.  This is found under Tools > Auto Correct
Options > AutoFormat.  UNCHECK the "Replace Straight Quotes with Smart Quotes" box.
 
2) compose your content in Notepad, or another all-text editor.  Save the text file, then paste the
email into the WYSIWYG editor.  Formatting it directly in the Create Message window as opposed to
Word will also make for cleaner formatting codes.
 
If you MUST use smart quotes, we recommend switching to the HTML Source View of your editor and
replacing the quotes with the HTML equivalent as follows:
 
left side quote: &ldquo;
right side quote: &rdquo;
apostrophe: &rsquo;
 
don't forget the semicolon at the end. 

WHY Does this Happen Anyway?  The reason (especially if you paste from Word) is due to the
different methods of character encoding.  Your web page and your Word settings might
use Unicode and ISO, respectively, and as such certain characters like a quotation mark are
represented as two totally different characters when their encoding is passed from one document to
another.  

This is also the reason that PC users who exchange emails with Mac users might find question marks
instead of spaces in replies, or other weird characters.

Why is "nobody@host.shovi.com" sending our emails out in eCampaigns?

We get a lot of questions as to why, in Microsoft Outlook, email messages sent via eCampaigns show
up as nobody@host.shovi.com on behalf of [sender's email address].  Here's the explanation:

When eCampaigns sends out an email, it is sending it out on your behalf directly from our server.  It
is not logging into your email account using your user name and password, and it isn't sending the
email out through your mail server.  As such, it would be improper to portray your email address as
the actual Sender in the email headers.

What's an email header? An email header is a set of information that tells email servers about the
message being delivered.  There is information about the Sender, who should be displayed in the
"From" field, whether replies to that email should go somewhere else, what server the message
originated from, and much more.  Well-formatted headers will help emails pass through security
checks on mail servers that use the headers to verify that the message is coming from a legitimate
source (and not being sent as spam).  
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So, by disclosing the fact that the "from" and "sender" address are two different people, it helps
verify the authenticity of your email message.

Also, Outlook is the only popular email application that displays the Sender address when you open
the message. You will notice, however, that the "From" field in the preview window still shows the
correct "From" address.

In conclusion, the display of the Sender header is an aesthetic issue which we've found to be noticed
more by senders than recipients.  In exchange for being able to send email with well-formatted
headers that will be delivered to more inboxes and not spam folders, we feel this is worth the
aesthetic inconvenience.

Adding sender email addresses to various email programs

We recently received an email newsletter from Staples® that had a link for how to add senders to
most popular email applications' address books, to help ensure that email delivery from their email
marketing activites ends up in the recipients' inboxes.

Even when eCampaigns says that it has delivered your email to all of the intended recipients, this
doesn't mean it reached their inbox. Spam filters, server settings and other factors could inhibit the
actual inbox delivery, but nearly all programs have a "list" that you can be added to that will bypass
all the server checks to get an email into their inbox.

Here is the link: http://e.staples-deals.com/staplespages/wrapper/index.asp. We encourage you to
keep this link on file to help troubleshoot why someone might not be receiving one of your email
messages from eCampaigns.  In the future we will offer a service to create a branded version of this
page for your particular business, and can even incorporate these instructions into the "thank you"
pages for your various lists.

Lessons from our first aggressive email marketing campaign

We recently helped a client send out an email campaign that was intended to drive fundraising
traffic to a particular initiative.  Proud to say it was extremely effective, but the point of this post is
to talk about what factors contributed to the success. 

There were three emails altogether...one last December (2006) to promote this fundraising initiative
in time for the holidays, one last week indiciating that there was "one week left" and one on Sunday -
- a day before the fundraising deadline. From this process we learned a few things worth sharing,
and they have application across any type of email campaign: 

    Create a sense of urgency - we used terms like "Last Chance" and "One Week Left" in our subject
lines, toward the FRONT of the subject line.  You have to be careful that you don't go overboard
(especially with all caps) because you will trigger many anti-spam filters and your email won't go
through to as many recipients.  But a sense of urgency in the beginning of the subject line will be
very helpful to get the reader to open up your message. 
    Tell them what they need to do - Once the email has been opened, provide links to your website
and make sure they stand out.  Don't use phrases like "Click here to visit our site", instead turn the
action statement into the hyperlink ("time is running out, use our secure online donation form to
make sure you make the deadline") was a phrase that pulled double-duty for us and was very
effective. 
    Get Link-Happy - Make sure you place the link to your "action page" in several places in the email
text, as well as on any images you have embedded in the email. 
    Get them to your site fast - Keep the text short...the point here is to create a sense of urgency to
go to the site.  Once you get the reader to your website, make sure any expanded text is clearly
displayed and easy to read, but also that they can "buy" or "act" without hunting for the starting
point (in our case, a form) 

These four points have application across any type of campaign, whether the goal be to promote a
piece of news or to drive commerce.  The key is truly to let your website do the hard work and let
the email just be the attention-getter.
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Marketing and Web Development
Articles and insight on online marketing and web development that don't fit

anywhere else.

Catch-all clickTAG code used in Flash banners

We recently encountered an issue with one of our clients who runs Flash banner advertisements
across a number of different websites, and each advertiser's ad specs was at odds with others.

Specifically challenging was finding a way to universally code the "clickTAG" variable that nearly all
online publishers use as the link to their advertiser's URL.  When the clickTAG concept first came
out as an accepted "standard" for ad publishing, the Flash script that we developers used to write
the clickTAG code wasn't case-sensitive.  But now it is, and there are some lingering variants like
clicktag, clickTag and ClickTAG still being used out there today.

To solve our client's problem we embarked on a journey through discussion forums and Google to
find someone who clearly realized this issue before us and posted a solution. Thanks to this post, we
came across scripting that will work on any derivative of the string variable "clickTAG".  The
CORRECT version, by the way, is clickTAG as sanctioned by Adobe (the company who owns Flash).

Toward the bottom of that post is a second block of code that we used.  It basically looks for the
string variable in the ad publisher's link that, when converted to all lowercase, will read "clicktag". 
Now it doesn't matter how the publisher writes their clickTAG spec, we'll be able to look it up and
assign it our own variable.

Here's the code: 
// --- on the main timeline ---
// define default value for flashclickTAG
flashclickTAG = "";
// check for clicktag
for (prop in _level0) {
if (prop.toLowerCase() == "clicktag") {
flashclickTAG = _level0[prop];
}
}
// define default value for flashclickTARGET
flashclickTARGET = "_blank";
// check for clicktarget
for (prop in _level0) {
if (prop.toLowerCase() == "clicktarget") {
flashclickTARGET = _level0[prop];
}
}
// --- on the button ---
on(release){
if ((flashclickTAG.substr(0, 5) == "http:") || (flashclickTAG.substr(0, 6) == "https:")) {
getURL(flashclickTAG, flashclickTARGET);
}
}

Please contact us if you have any questions.

Homepage ads - are they worth it?

So it's no secret that today's homepage shouldn't be the static, introductory text that it used to be. 
We actually design the homepage last, typically pulling in content from the rest of a website and
dropping the most important events, ads and links in full view the second a visitor comes to the
homepage. But the question is, do the really large ads that take up the first half of your web page
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actually work, in a world where banner ads have become as common as a cigarette butt on the
street, and glanced over just as quickly?

The answer is YES.  We recently tracked the number of click-throughs from a huge homepage ad on
one of our client's websites and measured conversions compared to visitors coming from regular site
browsing.  The numbers were very interesting: we found a conversion ratio of about 38% for regular
browsing and nearly 80% for visitors coming through the homepage ad.

Integrating your website into your online marketing mix 

It sounds obvious, right? Common sense tells you that your website, an online tool to market your
business, would integrate with your online marketing efforts. After all, you are driving traffic to your
website in your ads and listings using links. But is your website ready to give you the data you need
to analyze each of the channels driving traffic to your site; and are you taking advantage of some
basic metrics and online marketing tools to optimize the return on your advertising dollar?
There are four basic parts of the online ad, which (like all advertising campaigns) are centered
around a goal. First, establish the goal, whether it be lead generation, online sales, a newsletter sign-
up, whatever. Then, structure your ad and website to accomplish that goal.
The four parts to make your ad successful are:

    
    The ad
    
    
    The link
    
    
    The landing page
    
    
    The conversion page
    

We'll put these parts in play in a minute, but first, here is what needs to be reviewed from a visitor
or consumer's perspective:

    
    With your goals in mind, develop the ad to grab the attention of a specific individual looking for
your product or service.
    
    
    The consumer clicks on the ad and goes to your website to learn more about the information just
presented in your ad.
    
    
    The consumer buys your product or service, or basically does whatever it was that was set out as
the goal for the ad.
    
    
    You get the reward, whether it is a lead, sign-up, purchase, etc.
    

NOW, let's say you're doing this same set of steps across a variety of different channels...lead
generation, pay-per-click, organic search, newsletter, magazine, etc. How can you tell which
channels are doing the job, and are worth investing and reinvesting in?
Below are the same set of steps, but with the behind-the-scenes effort that puts you in better control
of your advertising dollars.

    
    With your goals in mind, now it is time to develop the ad to grab the attention of a specific
individual looking for your product or service.
    
    
    The consumer clicks on the ad and goes to your website and learns more about the information
that was just presented in your ad.
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    The link itself has a tracking code embedded in it...in fact, all of them do...so your visitor tracking
program can filter out all of the traffic from your marketing channels and report them to you
individually.
    
    
    The web page they land on, appropriately titled the "landing page" isn't your homepage. Instead,
it's a page custom-designed to put someone clicking on an ad directly in front of the information you
advertised.
    
    
    Or, if your ad is more general in nature, then you link to your homepage, but put a variety of
targeted "ads" on your own site that encourage the visitor to purchase, sign up or whatever your
goal was.
    
    
    Point being, don't focus your energy on driving qualified traffic to your website and then leave
them hanging; you know how they got to your site, you designed the ads...now give them what they
were looking for and turn them into customers!
    

The consumer buys your product or service, or does whatever it was that was set out as a goal for
that ad (called a conversion). Your webmaster places some code on your "thank you" page, or the
page that a visitor would land on after accomplishing the conversion. There should be a special
tracking code for each ad, and each marketing channel driving traffic toward this goal.
Since the above "path" is replicated for each advertisement and marketing channel, you or your
webmaster analyze them all periodically to identify which ones are effective enough to create
conversions and which aren't. Your tracking program helps by filtering out the activity to your
website using that unique tracking code, comparing it to conversions, which you compare to dollars
and cents to determine your return on online advertising spending.
Online marketing is a learning process. With each campaign you will learn more about which
advertisements or promotions generate leads and help you close business. Once you complete a few
campaigns you can compare the quality of the leads and rate of conversion and then determine
which online campaigns are most effective at generating business for your company. Then you can
concentrate your efforts on the methods that make a true impact on your bottom line.
We originally wrote this article for an advertising partner, DirectoryM, as part of their Best Practices
initiative for advertisers.  In 2006 Shovi Websites was asked to be a part of DirectoryM's Customer
Advisory Council. Thanks to DirectoryM we were able to develop a site management relationship
with the Illumination Engineering Society.

Interactive Content and Fixed-Width Layouts

In the November, 2007 issue of our favorite industry magazines, appropriately titled Website
Magazine, there is an article on the differences between Fixed-Width, Fluid or Elastic Design of a
web page. The article is a must-read for graphic designers and website owners before they embark
on their next layout design. While the article focuses on CSS differences, it alludes in its Pros and
Cons sections to a design point of view that we've had for a long time, that of "Content Drives
Design".

And with more websites developing interactive content we thought we'd jot down a few notes as it
relates to Interactive Content and Fixed-Width Layouts. Having a fixed width (note, nobody said
"fixed height") is great when you want a highly-designed layout that ensures nothing "floats" around
on the page, especially on a visitor's monitor with a larger screen resolution. But, if the primary
focus of your website revolves around interactive content, such as a photo album, calendar,
discussion board or blog, consider what a fixed-width layout could do to your content: 

    Thumbnail pages for your photo galleries are more limited 
    Copy-heavy pages need to have smaller font sizes to prevent limitless scrolling 
    Events in a grid-style calendar squeeze the layout of the grid 
    You essentially give yourself one "column" for content, advertising, and contextual links or
navigation options (like a "related articles" box) 
    Table text (like for a forum) gets squeezed 
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It's definitely more of an abstract concept to work in a variable width environment, and your design
standards have to be relaxed a bit to ensure that something like a menu link can wrap to two lines
and not destroy the layout. But whether it be fixed, fluid or elastic, in the end you need to do what's
best for your content, because that's what people are interacting with. 

We've run into challenges on some of our website layouts with regard to how to handle the pre-
defined area of a photo album, calendar, blog or discussion board, and after reading this article are
going back to some of our layouts to see if there is a better way meet the needs of the content by
incorporating fluidity into the layout. Bottom line, great job Website Magazine in reminding us that
Content Drives Design, and more importantly, putting together an article that helps identify when
and where we can switch to a different design format. 

On a positive note: most web designers will tell you that a fixed-width layout should be 760 pixels
wide, and you'll want to place the most important content above the 420 pixels mark to ensure that
visitors using an 800x600 monitor resolution won't have to scroll down to see a key content
element. We've been tracking the monitor resolutions over the last few years of visitors to our
clients' websites and have found that 800x600 (or smaller) represents only 15-17% of the browser
resolutions. Still significant enough to keep things to 760 wide, but insignificant enough to ask
yourself if your website's content might be better suited using another format (or going w i d e r).

Lessons from our first aggressive email marketing campaign

We recently helped a client send out an email campaign that was intended to drive fundraising
traffic to a particular initiative.  Proud to say it was extremely effective, but the point of this post is
to talk about what factors contributed to the success. 

There were three emails altogether...one last December (2006) to promote this fundraising initiative
in time for the holidays, one last week indiciating that there was "one week left" and one on Sunday -
- a day before the fundraising deadline. From this process we learned a few things worth sharing,
and they have application across any type of email campaign: 

    Create a sense of urgency - we used terms like "Last Chance" and "One Week Left" in our subject
lines, toward the FRONT of the subject line.  You have to be careful that you don't go overboard
(especially with all caps) because you will trigger many anti-spam filters and your email won't go
through to as many recipients.  But a sense of urgency in the beginning of the subject line will be
very helpful to get the reader to open up your message. 
    Tell them what they need to do - Once the email has been opened, provide links to your website
and make sure they stand out.  Don't use phrases like "Click here to visit our site", instead turn the
action statement into the hyperlink ("time is running out, use our secure online donation form to
make sure you make the deadline") was a phrase that pulled double-duty for us and was very
effective. 
    Get Link-Happy - Make sure you place the link to your "action page" in several places in the email
text, as well as on any images you have embedded in the email. 
    Get them to your site fast - Keep the text short...the point here is to create a sense of urgency to
go to the site.  Once you get the reader to your website, make sure any expanded text is clearly
displayed and easy to read, but also that they can "buy" or "act" without hunting for the starting
point (in our case, a form) 

These four points have application across any type of campaign, whether the goal be to promote a
piece of news or to drive commerce.  The key is truly to let your website do the hard work and let
the email just be the attention-getter.

Web addresses and advertising

Have you noticed how ads referencing a company's website have changed over the last few years?
The sophistication of today's consumer has allowed companies to make their domain name more
targeted, resulting in more detailed result data on their campaign. 

Enter the idea of the "slash ad", a URL that has multiple benefits for marketers and consumers alike.
"Slash Ads" Gone are the days where you need to write or say the "www." part of your domain
name; that saves 4 characters when space is an issue and about 1 second of expensive air time. 
What's replaced the "www." is what we've started to call a "slash ad", which is a "/" at the end of the
domain name followed by a phrase that is easy to remember and type.

12 of 25Generated by KnowledgeBuilder - http://www.activecampaign.com/kb



Popular slash ads as of this post are the UPS campaign "ups.com/whiteboard". 

Why Slash Ads are Effective Interestingly enough, following the URL above takes you to
http://whiteboard.ups.com.  UPS in this case decided that a subdomain would be better than a
dedicated website for their ad campagin, but the idea of how to type a subdomain hasn't caught on
yet. Other campaigns, such as Major League Baseball's www.actober.com Playoff website in
2004, took you to a dedicated website for the Major League Baseball Playoffs.  

In either case, the brand recognition and ease of pronounciation and typing for the "slash ad"
trumps the final URL for the campaign, making it an effective way to promote.  But there is one
other key component to the "slash ad": tracking... 

Tracking a Slash Ad We talked about how the two URL's above take you to another web page (not
the page you typed int your browser).  This was most likely done to keep the campaign separate
from the infrastructure of the rest of the website, but there are tons of other reasons not worth
getting into now. But to understand the effectiveness of the ad, especially in an offline promotion
where someone has to type in a URL to access your website (i.e. no referring URL data), a slash ad
will give you an idea of how many people responded to the ad.

Assuming you create a unique "slash ad" for each offline channel in which you want to promote the
campaign, you could track and measure the effectiveness of each, and shift your marketing dollars
accordingly next time around. Tracking methods include a 301 redirect (the fastest method of
redirecting, which basically replaces the URL the visitor types in with the destination URL)...we aren't
a big fan of these if you have multiple channels or slash ads going to the same place, because you
might miss the opportunity to log the slash ad URL in your analytics program.  A workaround would
be to have each slash ad redirect to a unique landing page, and then track the landing page.  Using
the META tag "refresh" is another popular redirecting method because you can track the actual slash
ad 'homepage' before the redirect (that's helpful for other reasons like whether or not it was easy to
type) but some browsers might block the refresh feature...your best bet if using a META refresh is to
provide one of those "redirecting...click here if your browser doesn't refresh in 2 seconds" links.

Going forward expect more of these "slash ads" as marketers look for ways to continue improving
ROI in their ad campaigns.

Web Hosting and Email
background information on server settings, email, hosting and other tech-related

items.

BoxTrapper Anti-Spam

Shovi Websites offers one of the most conclusive solutions in the fight against spam: BoxTrapper. 

BoxTrapper is a whitelist program, which means that ONLY email addresses that you approve (or
that approve themselves) are allowed to send you email.

This works as follows:

1) Someone sends you an email.  BoxTrapper checks the "From" address against your approved
list.  If the email is on the list, the email goes through.  If not...

2) The sender gets an automatic reply saying that they need to confirm their email address before
their email to you is released to your inbox.  This step is skipped by 99.999% of spammers, which
means that nearly ALL of your spam will stay in your "Queue" and never get delivered to your inbox.

3) the sender then replies to the confirmation message, BoxTrapper automatically adds their email
address to your list, and the email is delivered to your inbox the next time you check your email.

HOW CAN I EXPEDITE THE CONFIRMATION PROCESS?

Any time you send an email, those addresses are automatically added to your whitelist (makes
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sense, no?)  So as you go about your daily routine, sending out emails to your colleagues and
clients, most of those addresses will end up on your list, and those people won't have to complete
the verification step.

OR, you can go into your webmail interface (see our Support article on logging in), and click the
"BoxTrapper" > "Manage Lists" > "Edit Whitelist" links to manually add names, subjects, and other
filters to your whitelist.

We have found that it takes about 3 weeks to get the majority of your address book in the whitelist. 
Until then, you should make a practice of going into the BoxTrapper section of "webmail" and
"Review Queue" a few times a day; this will allow you to catch legitimate emails from your
colleagues and clients, and automatically whitelist them before they complete the verification
process.  In addition, the Queue is important to visit when signing up for newsletters, to make sure
the email address you are receiving the newsletter from gets on your whitelist.

NOTES/CAVEATS:

1)  The only problem we have found with BoxTrapper is that it does not work well when the client
has a Blackberry "pushing" email to the device.  This is because of the "push" process that
Blackberry uses to "deliver" email, instead of the common practice of logging into the server and
"retrieving" email ("pulling" it down from the server).

If you use a Blackberry frequently, this service is probably not a good fit.

Changing your email password

To change your email password, go to the "webmail" interface (read our Support Article on how to
do this if you don't know).

Click "Change Password" once logged in.

You'll need to type your new password twice, to make sure you typed it correctly.  We recommend
making your password difficult to guess, and not to store it in an easy-to-find place.  Try to use a
number/letter combination, instead of all numbers or all letters...these passwords are more difficult
to guess.

Click "Change Password".

NOTE: You'll need to adjust your settings in your computer's email program to successfully check
email from your PC.  Changing the password using the above instructions only changes it on the
server, not on your computer.  Similarly, you can't change your password on your computer and
successfully check your email via Outlook or another email client without making the same change
on the server using the steps above.

We recommend that if any of our users have administrators that manage all of the email passwords
for the company, that they create a "Password change" process to make sure that your records are
in sync with the current passwords on the server.

We are happy to help walk you through a password change; just give us a call.

Logging into Webmail

For most of our hosted clients, you have the ability to check your email from anywhere you have an
internet connection via our "webmail" interface.  Not only does the "webmail" interface provide
access to your email, but it also helps you set up other options related to your email account
(explained in other Support articles).

To sign in, go to www.YOURDOMAIN.com/webmail where YOURDOMAIN is your domain name.

You will see a pop-up login box. Your full email address is your login ID, and your password is your
email password.

Upon successfully loggin in, you will see a screen with three icons on it: NeoMail, Horde, and
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SquirrelMail.  Click on the program of your choice to access your email.

NOTES and Caveats:

1)  You don't have to worry about switching between webmail programs; all of your email that is on
the server is stored in one file, shared between the three.  So each will have the same messages in
your inbox, trash, sent items, and any other folders you create.  The different programs have
features which may be appealing to how you want to manage your mail online.

2) ONLY EMAIL STILL ON THE SERVER is available via webmail.  That means, if you use Outlook or
another mail client to check your email and download it to your computer, you will NOT be able to
access those emails.  We recommend shutting off your Outlook program when you're going to be
out of the office, so all of your emails while you're away will stay on the server for you to access.

3) ANTI-SPAM - if you run a localized anti-spam program (McAfee Spam Killer, Norton Anti-Spam,
etc.) on your computer, it will not be able to check emails still on the server, which means you'll still
get spam in your inbox.  Consider our BoxTrapper anti-spam solution, which traps spam on our
servers before even getting to your inbox!

4) BLACKBERRY/SMARTPHONES - if you're checking your email using a wireless device such as a
Blackberry or Smart Phone, keep in mind that, like the webmail programs, these will only be able to
check email that hasn't been downloaded to your PC yet.

5) SENT MESSAGES - Sent messages do not download to your Sent Messages file when you return to
your office and retrieve your emails from the server; they stay on our servers.  So if you have an
important email or discussion thread that you want to make sure ends up on your PC after you get
back in the office, make sure you BCC or CC yourself when you send or reply to email, so you get a
copy in your inbox.

 What Else Can I Do Here?

Glad you asked...in WEBMAIL you can also:

    Change your password 
    Set up a Vacation Auto-Responder 
    Configure and check your BoxTrapper Anti-Spam filter 
    Add server-level email filters 
    ...and more.

POP and SMTP Email Account Settings

Below are the correct settings to send and receive email using our servers. If your domain runs mail
off of an internal server (such as an Exchange server) or uses another third-party service (such as
Gmail) then you need to contact the people who support those services for help.

Please note that due to the variation in buttons, screens and labels among email clients (Outlook
2000, 2003, 2007, any Apple product, Thunderbird, etc.) we are just providing the settings and not a
step-by-step guide for your specific email client. If you cannot find the settings feel free to call us or
set up a chat if we're online.

Basic Required Settings

Incoming Mail Server (POP): mail.yourdomain.com (replace yourdomain.com with your domain)
Outgoing Mail Server (SMTP): mail.yourdomain.com (replace yourdomain.com with your domain)
User Name: full email address (i.e. john@doe.com)
Password: your email password

Advanced Required Settings

Outgoing server (SMTP) authentication: ENABLED (select the option to 'use same settings as
incoming server' for best results)
PORTS: Incoming (POP) - 110.  Outgoing (SMTP) - 26 (using 25 may result in sending errors)

Other Optional Settings & Recommendations
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We discourage enabling the option to "Leave mail on server" for any specified period of time as it
can cause problems with storage quotas and also sync issues between your inbox and the server.

You do not need to use any "secure" authentication or log in settings.

If we didn't provide information above for a field you see on your screen, you probably don't need to
fill it out, or it's just a label to make your email settings easier to find.

Transferring a Domain to our servers

We often have situations where our clients already have a website, or have secured a domain name,
and we need to move that domain name to our servers in order to go live with their website and
hosting.  While it isn't a mind-boggling process, it can get a little confusing, and as such we have
provided some basic insight below as to the necessary steps that go into a domain transfer.

We're changing the domain name's address...that's all.
Think of the DNS for a domain name as the address card you filled out for your elementary school
teacher on the first day of school.  It has all of your relevant contact information and locations.  For
a domain name, these "addresses" are IP numbers (example: 202.21.222.223) which correspond to
computers directly connected to the internet (not like your home computer, which connects to your
Internet Service Provider).

We have our own set of IP numbers on our servers.  So to move you to our servers, all we need to
do is change the "address card" to reflect the new IP address of your domain name.  It's really that
simple. 

So How and Where do we do this?
There are several options to transfer domain names to our servers, and it comes down to who you
want to control the "address card".  The place where you registered your domain name (example:
Network Solutions, GoDaddy), is called a registrar; they establish the original "address card" for you
when you buy the domain name from them on their "name servers".  And they'll let you change
addresses (A Records, MX records for mail, etc). if you want to keep everything in one place on their
"name server".  Often, clients who have IT departments or who have other servers will want this
option, so they can control the information as their company's IT and networking needs grow.

Or, you can give us access to your account so we can make the changes.  We have management
accounts at Network Solutions (ID: shovidesigns) and Register.com (ID: shovidesigns).  You can
invite us to be a Technical Contact on the account, and we can manage it from there.

The third option is to allow us to manage the "address card" on our name servers, which would
require you to go to your registrar account and make a name server change.  We will provide you
with the necessary info if you wish, or you can give us your login info and we'll take care of it.

With any domain name transfer, there is a 24-36 hour propagation period, where all of the
computers on the Internet update their "address cards" to make sure they direct traffic to your
domain name to the proper IP address.

If you have any questions, please don't hesitate to contact us.

Vacation Auto-Responders

To set up an autoresponder (typically for when you're going on vacation):

1) Log into webmail (read the support article on how to do that if you need to)

2) Click on "Autoresponders"

3) Fill in the "From" field with your name.

4) Change the "Subject" field if you want (RE: %subject% means that the autoresponder will take the
subject of the person's email and put a "RE:" in front, just as if you replied.  Other common options
for vacation are "Out of Office Reply: %subject%")
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5) Type in the body of what you want to say in your email ("I'm on vacation until January 3, please
contact my assistant if you have an immediate issue", etc).

6) Click "Set Up Responder".

NOTE: You only get ONE responder per account.  Once you are ready to remove the responder, just
go back into this screen and click "Delete AutoResponder".

 

What is Web Hosting and why do I need it?

Web hosting is an essential part of a successful website.  Websites are, for the most part, no more
than a set of files (images, documents, web pages, etc.) organized into folders and stored on a
computer.  To make the website accessible to someone typing in your domain name, you have to
store those files and folders under a "web hosting" account with a company whose computers
(called "servers") are physically connected to the rest of the Internet.

In other words, without web hosting, nobody can get to your website.

How Do I Choose?

There are thousands of hosting plans and an equal number of hosting companies out there, all
offering different levels of different parameters; enough to give you a big headache!  And to make
matters worse, many of the Internet's largest companies are making it look like they're throwing you
everything but the kitchen sink to get your business.  

The key to choosing the right hosting provider is reliability and service...THEN decide if the "specs"
and value-added features are worth the monthly fee.  We'll break down some of the more common
parameters below:

Disk Space - This is the amount of hard drive space that you're allowed to "rent" on the server from
the web host.  In our 6 years in business, we have found that most websites use between 10-200MB
of disk space...that's it.  So when a hosting company tries to lure you in by offering you 200GB of
disk space, keep in mind that to store 200GB of files and folders would require you to have about 3
regular desktop computers...is your website really THAT big?

Bandwidth - Anytime someone makes contact with the server, whether to have a web page
delivered, send or receive an email, upload or download a file, the size of those data requests
passing through the server are called "Bandwidth".  Again, in our 6 years in business, most websites
will shuttle about 1-10GB of bandwidth to and from the server in a given month.  If you're going to
have large podcasts, videos, and/or are sharing very large files on your website, then you can expect
your bandwidth usage to go up.  So back to our example, if a hosting company is offering you
100GB of bandwidth, that's just because they want to lure you in...there's a very unlikely chance
you're going to use it.

Email Accounts - Also known as POP accounts, these are the number of email accounts that you're
allowed to set up for members of your company.  If you have your own internal mail server, then
this is an unimportant factor to consider.  But for others, keep in mind that email does not take up
much disk space nor does it consume a lot of bandwidth (generally), so hosting companies telling
you that you can set up 50 email accounts with your hosting plan are just trying to lure you in with a
big number...do you have 50 people checking email in your company?  Will you ever?  If so, you're
going to want some tighter controls on your email, probably with a dedicated Exchange server
managed by someone on your IT staff.

FTP Accounts - "File Transfer Protocol" is the most common way to transfer files between computers
and servers.  And becaue it's the most common, it's also the most vulnerable to hackers and
attacks.  Many hosting companies will offer you a master FTP account to allow you to post changes
to your website, and some will offer additional FTP accounts to allow you to give restricted access to
your server for the purpose of posting files.

CGI-BIN, PHP, MySQL - all programming languages that allow you to run dynamic programs on your
website.  Being able to utilize today's latest technology on your website is very important to having
a site people will respond and come back to.
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IP Addresses - an IP address is a set of 4 numbers that looks something like 123.45.67.890.  The IP
Address is essentially an address for a computer/server connected to the Internet.  When you type
in a website address, that domain name has been assigned to an IP, so the computers and servers
know which server to go to for that domain name.  A Static IP is one where you're the only "folder"
assigned to it.  A Shared IP is one where there could be multiple websites ("folders") assigned, and
the server ensures you get to the right one when you type in a specific domain name.  There is no
real need for a Static IP address unless you're conducting e-commerce transactions from your
website, or you need a Secure Server for another reason.

Secure Server - a server that has encryption on a specific IP address, so that the website assigned to
it will enjoy a secure connection to its user.  You see https:// in the address bar and usually a gold
padlock or key in your status bar when viewing a secure site.  

Visitor Tracking - a website is essentially an employee of your company, and like all employees,
should be scrutinized to make sure it's doing its job.  Visitor Tracking is extremely helpful in telling
you how many people are coming to your site, from where, and what they are doing once there. 
Webalizer is a tracking program you may hear about with many hosting companies, because it
comes free as a built-in part of the server's operating system.  Unfortunately, it does nothing more
than regurgitate the way your bandwidth was used...oh, and they aren't real time either.

The bottom line about web hosting is that you want to make sure that your website is UP AND
RUNNING, and that if there's a problem, you can CALL someone to get it fixed.

"Website Updates" Policy

Effective as of March 19, 2009.

Updates, previously called "Support Units," are defined as individual requests to manage content on
a client's website. 

Examples of a Standard Update include, but are not limited to:

    changing existing copy on an existing web page, 
    adding new copy to an existing web page, 
    creating 'banners' or other graphics that link to pages within your website using previously
defined dimensions and specs,
    adding incremental content to an existing section using previously defined parameters (such as
adding a press release with associated photo and caption). 

Help Desk Requirement. All updates must be processed through our Help Desk system, either by
submitting a ticket or emailing updates@shovi.com with the request. We guarantee that all requests
will be completed within 2 business days, provided that the information submitted in the original
ticket is complete, and there are no follow-up questions. Once all support information has been
received and questions answered/confirmed, the 2 business day timeline begins.

Telephone Requests.  We encourage communication via email for optimum efficiency; however, we
are available during the hours of 10:00 AM through 1:00 PM for brief discussions on support issues
via telephone.  Limiting support via telephone increases the accuracy and efficiency with which we
can process update requests and allows availability for sales and development discussions with our
clients.

Guarantee. We guarantee the completion of your ticket within 2 business days provided it complies
with the requirements above. In the event an update that complies with all of our Standard Updates
requirements takes longer than 2 business days we will not count it toward the number of updates
included in the client's Site Management plan.  

"Day 1" starts at 8:00 AM, "Day 2" ends at 5:00 PM the next business day.  If a ticket arrives in our
Help Desk at 3:00 PM on a Thursday, its first day of the 2-day guarantee is Friday, the second day is
Monday.  If a ticket arrives in our Help Desk at 7:45 AM on a Thursday, the first day of the 2-day
guarantee is Thursday, the second day is Friday.  All times are Eastern (US).

Proofs.  Unless you specifically request otherwise, Updates will be made live, not "for proof;"
therefore it is important that you 'vet' or otherwise approve the format of the updated content prior
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to submitting it to the Help Desk.  Should you require a proof page first, make the request explicitly
when you submit the update, which will not qualify for the 2 business day completion guarantee.  If
a proof is required, we will provide a single round of edits (if required) after which the edits will be
made live and the ticket closed.  If, during the proof and reply period, you request more rounds of
proofs, this will no longer be considered an Update. The ticket will then be converted to a billable
service.

Tracking. It is the your responsibility to track the number of updates submitted through our Help
Desk ensure they do not exceed the preset number of updates specified in your Site Management
plan.  Should you exceed their preset number of updates, additional requests will be billed
automatically at the appropriate billing rate, usually $25/request.  By registering as a user with the
Help Desk you can easily track the activity on your account.

Premium Updates.  In the event you require completion sooner than the standard 2 business day
timeframe, Shovi Websites will automatically bill the client at a rate of $60/hour with a $25
minimum, even if the client's Site Management plan still has Standard Updates available.  "Same
Day" updates are not guaranteed after 1:00 PM.

Rollover.  There is no "rollover" of unused updates. However, Shovi Websites will monitor your
updates and take inactivity into account when pricing billable requests, such as website redesign,
email marketing or a programming feature.

Technical, Hosting, Email Support.  Where possible, all requests for technical, hosting or email
support must be made through our Help Desk in the appropriate Department. The more specific you
can be in providing details about the issue or error, the easier it will be for us to troubleshoot. In
the event of a true emergency, you can contact our offices at any time.  

Generally speaking, we do not want to make technical support a billable item that requires
guidelines and parameters as outlined above & below.  However, in an effort to keep this service a
free one, we may suggest online references on the appropriate topics to discuss with your IT
department.  If all else fails, Shovi Websites reserves the right to bill the client for time spent
troubleshooting their specific issue.

Pricing and Scope of Non-Update Servicing. If a request does not fit within the parameters of a
Standard Update according to the above Website Updates Policy, we reserve the right to provide a
quote for the request at the appropriate billing rate using the table below.  Rates are subject to a
1/3 hour minimum.  At times, Shovi Websites may elect to forego billing for certain requests as a
matter of good faith and business; these decisions are isolated and should not be considered 'rule of
thumb' by the client.

    
        
            Service Category
            Rate/Hr
        
        
            Programming/Dynamic Content Support
            $120/hr
        
        
            Marketing (eCampaigns, SEO, PPC)
            $90/hr
        
        
            Graphic Design (banners, Flash)
            $90/hr
        
        
            Analytics/Campaign Support
            $75/hr
        
        
            "General" Billing Rate
            $75/hr
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FTP Instructions (General)

On select occassions we will offer our FTP portal up to our clients (or their clients) to transfer large
files.  There are a variety of programs available for using FTP, or if you have Windows XP you can
use their built-in file browser as an FTP client. Below we explain how to do this.

Open up a folder in Windows, and make sure you can see the file path (for example: C:\Documents
and Settings\Me\Desktop)

In the file path bar, erase what's there and type ftp.shovi.com (or whatever domain we have
provided you), then hit Enter.

You will receive an error message.  Don't worry. Click OK.

Your window will still look like the inside of a folder but will be empty, so go to the File menu and
select "Login As..."

Use the login credentials we've provided you as a user name and password, then click Login.

You can now drag files back and forth between the FTP folder and your hard drive, just as if the FTP
folder were a folder on your computer.  When you are finished, simply close the FTP window to end
the session.
FTP Software and Browser Plug-Ins

If you use Firefox 3 there is a plug-in called FireFTP that is free, secure, and lets you save your login
information without dealing with these error messages.  It works very similarly to many popular FTP
software applications, like Fetch (for Mac), RBrowser (Mac and Vista), and CuteFTP (Windows).

Your Most Common Post-Launch Questions Answered

In an industry where instant gratification is seemingly the norm, we find ourselves answering three
common questions in the first week or two after launching a new website for a client.  Clearly it is a
very exciting time for them and, despite all efforts to help answer these questions ahead of time,
sometimes "you just need to see it to understand what we were talking about." 

This article isn't meant to poke fun or be cynical, rather to help funnel our client's excitement down
a path that can actually help their business get the most out of its new website.

For the purposes of example let's assume that we've just launched a website for a consulting
company based in New York that provides services to the transportation industry.  The website is
brand-new, not a redesign.
Q:  When I typed "transportation consulting" into Google we weren't #1.

A: A number of factors go into being listed #1 in Google for a broad-match term like this.  Put
simply, if your website is brand-new and we provided some level of search optimization service
related to this term, expect to wait between 6-12 weeks to be ranked in Google, Yahoo, MSN and the
other major engines.  If we submitted a site map to the engines (which we usually will do) your
pages will find their way into the search results within a matter of days (called being 'indexed'), but
the actual ranking won't take place for a while.  This is how search engines operate.

Search engine optimization services generally cost thousands of dollars and are long-term in nature;
not being #1 after a week of being online is being a bit hasty...

...unless you're paying for placement.  If you are running a pay-per-click (PPC) campaign in Google
and targeting "transportation consulting" you should still expect to wait a few days to a week before
getting worried that your ads aren't showing up.  A variety of factors go into getting that #1 spot,
which we probably discussed with you when we started to set up the PPC campaign scope and
budget.
Q:  How do we find out the email addresses of the people visiting our website...I see that we can
view their IP addresses but not their email addresses.

A:  So you're basically saying you want to harvest personal information that goes beyond just the
unobtrusive "cookie" data that gets placed on the visitor's computer by our tracking system?  You're
asking to place spyware on their computer.  That's illegal and not what visitor tracking does.  By
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the way, what would you do with the email addresses? Send them emails to follow up on their
visit?  Would they be solicited emails?  No, they wouldn't...that's called spam which is also illegal.  

So instead of getting off on the wrong foot, it's probably best to harvest those leads not by prying
into the computers of your visitors but by old fashioned lead generation: get them to subscribe to a
newsletter which has a series of auto-responders in it, set up live chat invites on specific pages
or promote call back forms and quote forms.
Q:  How do I access the content to change something? I can't seem to log in.

A:  If you do not have a content management script on the site (which you'd know about ahead of
time, we build them for our clients as part of the scope of work), then you can't update anything. If
you do have a content management script then whatever is tied to that script can be updated by
you using the login information and training we provided for the script.  

So to make those changes simply submit a ticket to our Help Desk with the information to be
updated and we will turn around the change in a matter of 1-2 business days.

Adding Shovi Websites as an Account Exec

If you have purchased a domain name through www.ShoviDomains.com chances are it is in
conjunction with a website launch that we will be hosting for you.  Please see this article on how to
change the nameservers for your new domain to point to our servers, OR read below for how to add
Shovi Websites as an Account Exec so we can do it for you.
Assign Shovi as an Account Exec

    Log into your account at www.ShoviDomains.com 
    Click the "My Account" tab on the left, then the "Domains" link to open up the Domain Manager
screen
    Click the "Folders" link on the left menu of the Domain Manager screen  
    Click the checkbox next to "All My Domains" and then click the Account Exec icon above.  
    A box will open asking you to assign an Account Exec. Select "New Account Exec".  
    A new window will appear asking you to fill out the following information for your Account Exec: 
First Name: Shovi 
Last Name: Websites 
Email: 

Confirm Email: 

 
    It is important that you provide the email address listed above. Complete the confirmation steps
so we can receive the email invitation, which we will accept and then have access to your domains
via our own account. From there we will change the necessary nameserver information for this and
any future domains you purchase from us.
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Website Analytics
articles on how to make the most out of our real-time stats service and other traffic-

oriented systems.

Your Most Common Post-Launch Questions Answered

In an industry where instant gratification is seemingly the norm, we find ourselves answering three
common questions in the first week or two after launching a new website for a client.  Clearly it is a
very exciting time for them and, despite all efforts to help answer these questions ahead of time,
sometimes "you just need to see it to understand what we were talking about." 

This article isn't meant to poke fun or be cynical, rather to help funnel our client's excitement down
a path that can actually help their business get the most out of its new website.

For the purposes of example let's assume that we've just launched a website for a consulting
company based in New York that provides services to the transportation industry.  The website is
brand-new, not a redesign.
Q:  When I typed "transportation consulting" into Google we weren't #1.

A: A number of factors go into being listed #1 in Google for a broad-match term like this.  Put
simply, if your website is brand-new and we provided some level of search optimization service
related to this term, expect to wait between 6-12 weeks to be ranked in Google, Yahoo, MSN and the
other major engines.  If we submitted a site map to the engines (which we usually will do) your
pages will find their way into the search results within a matter of days (called being 'indexed'), but
the actual ranking won't take place for a while.  This is how search engines operate.

Search engine optimization services generally cost thousands of dollars and are long-term in nature;
not being #1 after a week of being online is being a bit hasty...

...unless you're paying for placement.  If you are running a pay-per-click (PPC) campaign in Google
and targeting "transportation consulting" you should still expect to wait a few days to a week before
getting worried that your ads aren't showing up.  A variety of factors go into getting that #1 spot,
which we probably discussed with you when we started to set up the PPC campaign scope and
budget.
Q:  How do we find out the email addresses of the people visiting our website...I see that we can
view their IP addresses but not their email addresses.

A:  So you're basically saying you want to harvest personal information that goes beyond just the
unobtrusive "cookie" data that gets placed on the visitor's computer by our tracking system?  You're
asking to place spyware on their computer.  That's illegal and not what visitor tracking does.  By
the way, what would you do with the email addresses? Send them emails to follow up on their
visit?  Would they be solicited emails?  No, they wouldn't...that's called spam which is also illegal.  

So instead of getting off on the wrong foot, it's probably best to harvest those leads not by prying
into the computers of your visitors but by old fashioned lead generation: get them to subscribe to a
newsletter which has a series of auto-responders in it, set up live chat invites on specific pages
or promote call back forms and quote forms.
Q:  How do I access the content to change something? I can't seem to log in.

A:  If you do not have a content management script on the site (which you'd know about ahead of
time, we build them for our clients as part of the scope of work), then you can't update anything. If
you do have a content management script then whatever is tied to that script can be updated by
you using the login information and training we provided for the script.  

So to make those changes simply submit a ticket to our Help Desk with the information to be
updated and we will turn around the change in a matter of 1-2 business days.
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Website Updates
Pointers and articles on how to manage your websites' content, whether it be

through us or a back-end system we designed for you.

"Website Updates" Policy

Effective as of March 19, 2009.

Updates, previously called "Support Units," are defined as individual requests to manage content on
a client's website. 

Examples of a Standard Update include, but are not limited to:

    changing existing copy on an existing web page, 
    adding new copy to an existing web page, 
    creating 'banners' or other graphics that link to pages within your website using previously
defined dimensions and specs,
    adding incremental content to an existing section using previously defined parameters (such as
adding a press release with associated photo and caption). 

Help Desk Requirement. All updates must be processed through our Help Desk system, either by
submitting a ticket or emailing updates@shovi.com with the request. We guarantee that all requests
will be completed within 2 business days, provided that the information submitted in the original
ticket is complete, and there are no follow-up questions. Once all support information has been
received and questions answered/confirmed, the 2 business day timeline begins.

Telephone Requests.  We encourage communication via email for optimum efficiency; however, we
are available during the hours of 10:00 AM through 1:00 PM for brief discussions on support issues
via telephone.  Limiting support via telephone increases the accuracy and efficiency with which we
can process update requests and allows availability for sales and development discussions with our
clients.

Guarantee. We guarantee the completion of your ticket within 2 business days provided it complies
with the requirements above. In the event an update that complies with all of our Standard Updates
requirements takes longer than 2 business days we will not count it toward the number of updates
included in the client's Site Management plan.  

"Day 1" starts at 8:00 AM, "Day 2" ends at 5:00 PM the next business day.  If a ticket arrives in our
Help Desk at 3:00 PM on a Thursday, its first day of the 2-day guarantee is Friday, the second day is
Monday.  If a ticket arrives in our Help Desk at 7:45 AM on a Thursday, the first day of the 2-day
guarantee is Thursday, the second day is Friday.  All times are Eastern (US).

Proofs.  Unless you specifically request otherwise, Updates will be made live, not "for proof;"
therefore it is important that you 'vet' or otherwise approve the format of the updated content prior
to submitting it to the Help Desk.  Should you require a proof page first, make the request explicitly
when you submit the update, which will not qualify for the 2 business day completion guarantee.  If
a proof is required, we will provide a single round of edits (if required) after which the edits will be
made live and the ticket closed.  If, during the proof and reply period, you request more rounds of
proofs, this will no longer be considered an Update. The ticket will then be converted to a billable
service.

Tracking. It is the your responsibility to track the number of updates submitted through our Help
Desk ensure they do not exceed the preset number of updates specified in your Site Management
plan.  Should you exceed their preset number of updates, additional requests will be billed
automatically at the appropriate billing rate, usually $25/request.  By registering as a user with the
Help Desk you can easily track the activity on your account.

Premium Updates.  In the event you require completion sooner than the standard 2 business day
timeframe, Shovi Websites will automatically bill the client at a rate of $60/hour with a $25
minimum, even if the client's Site Management plan still has Standard Updates available.  "Same
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Day" updates are not guaranteed after 1:00 PM.

Rollover.  There is no "rollover" of unused updates. However, Shovi Websites will monitor your
updates and take inactivity into account when pricing billable requests, such as website redesign,
email marketing or a programming feature.

Technical, Hosting, Email Support.  Where possible, all requests for technical, hosting or email
support must be made through our Help Desk in the appropriate Department. The more specific you
can be in providing details about the issue or error, the easier it will be for us to troubleshoot. In
the event of a true emergency, you can contact our offices at any time.  

Generally speaking, we do not want to make technical support a billable item that requires
guidelines and parameters as outlined above & below.  However, in an effort to keep this service a
free one, we may suggest online references on the appropriate topics to discuss with your IT
department.  If all else fails, Shovi Websites reserves the right to bill the client for time spent
troubleshooting their specific issue.

Pricing and Scope of Non-Update Servicing. If a request does not fit within the parameters of a
Standard Update according to the above Website Updates Policy, we reserve the right to provide a
quote for the request at the appropriate billing rate using the table below.  Rates are subject to a
1/3 hour minimum.  At times, Shovi Websites may elect to forego billing for certain requests as a
matter of good faith and business; these decisions are isolated and should not be considered 'rule of
thumb' by the client.

    
        
            Service Category
            Rate/Hr
        
        
            Programming/Dynamic Content Support
            $120/hr
        
        
            Marketing (eCampaigns, SEO, PPC)
            $90/hr
        
        
            Graphic Design (banners, Flash)
            $90/hr
        
        
            Analytics/Campaign Support
            $75/hr
        
        
            "General" Billing Rate
            $75/hr

Recommended Procedures for Transferring Large Files

We would prefer that the following guidelines be used when transferring large files across our
network.  These guidelines apply to the aggregate size of the files you're trying to send us (in other
words, if there are twenty 1MB files use the guidelines for a 20MB file).

< 5MB -- email is fine.  Keep in mind that if your email account has our standard 5MB cap this could
cause a problem.  Most ISP's won't allow much more than 5MB to pass through their servers at once.

5MB - 20MB -- we would recommend using FTP to transfer the files.  FTP access is available on our
servers, but we prefer to control access for security reasons.  As such, email us requesting FTP
access and we will send you information on how to do so.  Windows XP users - there is an FTP agent
built-in to Windows Explorer.  All other operating systems would need to acquire an FTP program
like Fetch (for Mac) or CuteFTP (Windows).
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20MB - 50MB -- FTP is definitely preferred, although it might take a while to upload.  You can also
burn us a CD at this point.

Over 50MB -- we would definitely recommend burning a CD of your files and mailing it to us.

Text formatting, page encoding and "smart quotes"

Smart quotes (or "curly" quotes) - there's an issue with the way text readers interpret them, so if
you ever paste them into a WYSIWYG editor you run the risk of the quotes coming out VERY funny
looking.
 
Generally, people using our WYSIWYG editors are publishing their content after typing it out in MS
Word or other word processor.  This creates extra formatting tags that can be easily copied and
pasted into a WYSIWYG editor, BUT the formatting may not be correct HTML formatting.
 
To avoid this issue, we recommend using straight quotes.
 
1) turn OFF smart quotes in your Microsoft Word settings.  This is found under Tools > Auto Correct
Options > AutoFormat.  UNCHECK the "Replace Straight Quotes with Smart Quotes" box.
 
2) compose your content in Notepad, or another all-text editor.  Save the text file, then paste the
email into the WYSIWYG editor.  Formatting it directly in the Create Message window as opposed to
Word will also make for cleaner formatting codes.
 
If you MUST use smart quotes, we recommend switching to the HTML Source View of your editor and
replacing the quotes with the HTML equivalent as follows:
 
left side quote: &ldquo;
right side quote: &rdquo;
apostrophe: &rsquo;
 
don't forget the semicolon at the end. 

WHY Does this Happen Anyway?  The reason (especially if you paste from Word) is due to the
different methods of character encoding.  Your web page and your Word settings might
use Unicode and ISO, respectively, and as such certain characters like a quotation mark are
represented as two totally different characters when their encoding is passed from one document to
another.  

This is also the reason that PC users who exchange emails with Mac users might find question marks
instead of spaces in replies, or other weird characters.

WYSIWYG Editors and Internet Explorer 7

Many of the programs we install on our clients' websites have HTML editors embedded in them to
allow clients to format their content updates.  These editors are called WYSIWYG ("What You See Is
What You Get") editors, and are essentially standalone JavaScript programs.

Internet Explorer 7 added a new setting to its security features, and as a result disabled many
WYSIWYG editors' capabilities.  You'll probably see the editor but not be able to do anything with it
(and you'll probably see red x's in the areas where the buttons are supposed to be, like broken
images).

But there is hope!

Go to Tools > Internet Options > Advanced Options > ActiveX Settings and set "Allow Scriptlets" to
ENABLE.
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